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Introduction 

The main purpose of any spreadsheet is to manipulate and present numbers. However, numbers can 
mean little unless they are accompanied by a few important things: 

•  titles and other information explaining the reason for the data and how the data was acquired 

•  labels on individual numbers or sequences of numbers explaining what the numbers refer to 

•  formatting of the numbers themselves to make their meaning as clear as possible 

•  formatting of cells containing numbers to draw attention to important parts of the data 

All these come under the general heading of formatting. We are not concerned here with the 
mathematical manipulation of numbers but with their presentation and visual emphasis. 

Excel has a large range of very powerful formatting facilities that enable you to present numbers and 
text on your sheet precisely as you want. It also gives you some preset formats so that if you are not 
sure what combinations of formats are likely to work you can choose one that has been tested. 

 

Opening the Example File 
1. Start Excel 

2. Open the file tut26.xls, which is on the H: drive in the Excel folder: 

 

3. Save the file as tut26 in the My Documents folder
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Simple Text Formatting 

Objective To format text on the spreadsheet. 

Instructions You will use the Format menu for nearly all of the formatting exercises which 
follow. In this exercise you will use the Cells... command. 

Comment Formatting text is very similar to most other  Windows applications. 
 

Activity 1 Select cell A1 containing the title "Sales for Vino plc".  
 
Select Format!Cells from the menu. The Format Cells dialog box will appear. 
 
Click on the Font tab at the top of the box: 

 

Activity 2 This tab gives a complete set of options for formatting the text. 
 
Whatever formatting you apply, you will see the result in the Preview box. 

•  In the Font box choose Bookman Old Style. 

•  Select Bold from the Font Style box. 

•  Select 16 from the Size box. 

•  In Color, select Red. 

When you have finished click . 
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Row Heights and Column Widths 

Objective To alter the height of rows and the width of columns to enable better display of the 
data. 

Instructions You will use the Row>Height and Column>Width commands from the Format 
menu, and also some mouse operations. 

Comments Excel always creates new spreadsheets with a default column width and row height. 
It is often better for presentation if these are altered to suit the contents of the rows 
and columns. 

 

Activity 1 The information in column F is too big for the width of the column. 
Select column F by clicking the column header once.  

Activity 2 Select Format!Column!Width from the menu. The Column 
Width dialog box will appear: 

 
In this dialog box you can specify the exact width you want your columns to be. It is, 
however, much easier to get Excel to calculate the best width for the column for you. 
Click  to close the box. 

Activity 3 Select Format!Column!Autofit Selection from the menu. Column F will 
be widened so that the text Actual Sales fits exactly. 

Activity 4 Row height can be altered in a similar way. A row will deepen automatically if you 
increase the font size in one its cells (you can see this by looking at Row 1). There is 
also a shortcut using the mouse. 

Move the mouse to the row headers on the left hand side of the worksheet. On the 
line between row headers, the cursor changes to . 

Move the cursor so that  is between rows 6 and 7. Drag halfway down row 7. A 
dotted line shows where the new base to row 6 will be. Release the button and row 6 
is 50% deeper. 

Note As you move the mouse across the column headers the pointer changes to . This 
provides the same shortcut for columns. In fact, if you now double-click it will resize 
the column to the left or the row directly above to be the best fit for the contents. 
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Aligning Data in Cells 

Objective To alter the position of data within and across cells. 

Instructions You will use the Alignment tab in the Format Cells dialog box and also a 
toolbar shortcut. 

Comments The ability to alter the width and height of cells means that the position of data 
within cells may end up not looking quite right. Excel provides facilities for altering 
this. 

 

Activity 1 The quarterly titles would look better if they were centred in their cells rather than 
left aligned. 
 
Select the range B6:G6. Then select Format!Cells.... 
 
In the Format Cells dialog box select the Alignment tab: 

 

Activity 2 Select Center from the Horizontal drop-down list and Center from the 
Vertical drop-down list, and click . The titles should be centred in 
their cells. 

Activity 3 Select the range A1:G1. This covers the range of columns that the table is in. Click 

the Merge and Center tool, . The text "Sales for Vino plc" is 
centred across the entire table. 

Activity 4 Select cell H7. Type the following: "The sales figures on average are above 
the targets. The only exception in these results was due to illness". 
Press ↵ . 

The text is on one line and stretches out of view of the spreadsheet.  
Select the range H7:J10. Then select Edit !Fill!Justify. The text is 
redistributed across the cells in the selection. 
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Simple Number Formatting 

Objective To format a range of numbers. 

Instructions You will use the Number tab in the Format Cells dialog box. 

Comments Remember that numbers can have text formatting such as font, style, colour and 
alignment applied to them as well as special number formats. 

 

Activity 1 Select the range B7:E10 by dragging the mouse diagonally from B7  to E10. 

Activity 2 Select Format!Cells  from the menu. The Format Cells dialog box will appear. 
If necessary, click the Number tab.  

By default the dialog box will show you all the preset formats available in Excel. 
These have been grouped into categories so that you need only view the ones 
relevant to you. A sample corresponding to the current selection is at the top of the 
box. 

Activity 3 Click on Currency in the Category list box. The dialog box changes: 

 

Activity 4 The right hand side of the box shows the preset format alternatives available in the 
currently selected Category. In the case of Currency, the presets for negative 
values are shown. Set Decimal Places to 0, select the last preset format and 
click . Your table should now look like this: 

 

More information on number formatting is in the Appendix 
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Formatting Cell Borders 

Objective To add formatting enhancements to whole cells. 

Instructions You will use the Border tab in the Format Cells dialog box. 

Comments Borders are particularly effective on spreadsheets for displaying tables. 
 

Activity 1 Select the whole table A6:J12. 
 

Select Format!
Cells from the 
menu, and the 
Border tab from 
the dialog box. 
The dialog box 
will appear thus: 

 

Activity 2 To put a box around the whole table: 
 
 In the Style box, click on the medium thick line  (second column, fifth row) and 
from the Color box select Dark Green (first row, fourth colour). You should see 
the line in the Outline box change with each complementary selection you make. 
 
Click the Outline Preset. 
 
Click  and a dark green thick border should appear around the selection. 
It will appear purple whilst the range is selected, but if you click outside the range it 
will be shown to be green. 

Activity 3 Select the range A6:A12, containing the row labels. Format!Cells!Border 
again, and this time put a right hand border on the selection. Click . 

In the same way put a medium weight dark green border on the following: 

Right Hand border on the range E6:E12 

Bottom border under row 6 from A6:J6 

Bottom border under row 10 from A10:J10 

To see what the spreadsheet should look like at this point, turn to page 8. 
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Formatting Cell Patterns 

Objective To add further formatting enhancements to whole cells. 

Instructions You will use the Patterns tab in the Format Cells dialog box. 

Comments Patterns can be effective on spreadsheets for drawing peoples’ attention to 
particular data, or by making large tables of data easier to read. Colour used well 
can also add a lot of clarity to a presentation, but used badly it can be distracting 
and unhelpful. 

 

Activity 1 Select the range F6:F10. 
 
Choose Format!Cells from the menu, and the Patterns tab from the dialog 
box to display: 

 

Activity 2 The following illustrates the use of the Patterns dialog box.  

In  the Color palette click yellow. 

Click the Pattern drop-down arrow and select one of the striped patterns from the 
top half. The sample box will now show a black pattern. 

Open the Pattern palette list box again, select click 
blue from the lower half of the palette and click 

. 

The yellow background and blue stripes pattern is put 
into the background of the cell, but has now made the 
text almost unreadable. This is the danger of badly 
chosen colour. You will correct this in the next task. 
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Deleting and Copying Cell Formats 

Objective To delete a set of formats from a cell without deleting the cell contents and to copy a 
set of formatting enhancements from one set of cells to another. 

Instructions You will use Copy, Paste Special and Clear from the Edit menu. 

Comments It is often more convenient to copy an existing set of formats from one cell to another 
than to reformat the new cell. It is also useful to be able to remove a cell’s 
formatting without removing the entire cell. 

 

Activity 1 Select the range F6:F10 
 
Select Edit!Clear from the menu. A submenu appears: 
 

 
 
Click on the word Formats. All formatting is removed from the cells. 

Activity 2 The borders, alignment and currency formats that were originally applied to cells F6 
and F10 have been deleted. You can put these back manually but there is a simpler 
way. 

 Select the range D6:D10. 

Click Format Painter, , on the Standard (top) toolbar. 

An active dotted box appears around the selected range, and the cursor changes to 
. 

Now select the range F6:F10. When you release the mouse button the range F6:F10 
will have the same formatting as the range D6:D10. 

 

Result of Formatting Cell Borders 
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Using the Formatting Toolbar 

Objective To use the formatting toolbar instead of some of the menu commands. 

Instructions You will use the buttons on the second toolbar at the top of your screen. 

Comments Toolbars are often much quicker and easier to use than menus, and the formatting 
toolbar is especially useful if you are doing a lot of formatting on your spreadsheet 
all at once. 

 

Activity 1 At the top of the screen you will see two toolbars. The upper one is known as the 
Standard Toolbar. The other is called the Formatting toolbar: 

 

Activity 2 Select the range A7:A10 with the row labels in, and click on Italics, . The 
contents of the selected cells all become italicised. 

Activity 3 Select the range G6:G12 and click on . A palette 
of colours appears. You can tear off the palette by 
dragging it down into the worksheet. 

 Choose the light grey colour (last row, second column). 
The cells are shaded light grey.  

Activity 4 Select the data in the two columns Actual Sales and Target, range F7:G12. 
Click on the Currency tool, . The selected cells take on a currency format with 
two decimal places. If ##### appears in a cell, increase the column width. 

Activity 5 Select the original data in the range B7:E10. Click on Decimal increase, , 
twice to put two decimal places onto the figures so that all the numbers are formatted 
identically. 

Finishing off 

 After all your formatting your spreadsheet should look something like the one below: 

 
 
Save the workbook as FORMDONE in the folder My Documents and then close it. 



 

excel 2002 datapres md rev dl.doc, 12/02/03 16:49, DL 10 

Charting 

Charting is one of the clearest methods of presenting bulk numerical data. 

There are two main reasons for drawing charts: 

•  as part of some data analysis so that you can see more clearly what the 
numbers mean. 

•  to present to other people. 

Excel has a range of 2-D and 3-D Standard chart types. All of these types have sub-
types. There is also arange of built-in Custom types. Altogether, the chart types 
provide a large range of graphs appropriate to analysis and presentation. 

The exercises that follow give practice in creating and changing a chart. 

Opening the Example File 

Open the file tut28.xls in the Stu directory (see page 1). The file will load as 
shown below. 

 

Save the file as tut28 in My Documents. 
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Creating a New Chart 

Objective To create a new chart in a separate worksheet from the data. 

Instructions You will use Chart from the Insert menu to invoke the Chart Wizard. 

Comment In the last step of the Chart Wizard,  you decide whether the chart is be created in a 
separate sheet or is to be embedded in the current sheet.  

 

Activity 1 On the sheet select the range A6 to D10. From the Insert menu choose Chart. 
The Chart Wizard dialog box will appear: 

Activity 2 Follow through the Chart Wizard steps, filling the options in as given below: 

Step 1 Select the Column chart type. Click . 
Step 2 Check that the Data Series is correct. You can, if necessary, reenter 

that data range by dragging through the range on the sheet. Click 
. 

Step 3 No changes here, so click  

Step 4 Click As new sheet and click . 

Your chart should look like this: 

Sally, Ann, Ray and John
are the Categories

This axis
shows the

Values

Each bar is
called a Data

Marker

This is a
Tick Mark

This is the x-axis

This is the
y-axis

 

The exercises that follow show how to use menus and toolbars to change some of the 
options set via the Chart Wizard. 



 

excel 2002 datapres md rev dl.doc, 12/02/03 16:49, DL 12 

Adding Titles and Labels 

Objective To add a title and axes labels to the chart and then edit them 

Instructions You will use the Titles tab on the Chart options dialog box. 

Comment Charts, like numbers, will be meaningless unless there is information on what the 
chart is about and what the elements of the chart are supposed to represent. 

 

Activity 1 Select Chart!Chart Options from the menu.... The following dialog box 
will appear. 

 

Activity 2 Enter the following into the first three boxes: Title,  X Axis and Y Axis. Click 
. You could enter here the final title that you want but the point of this 

exercise is to change them on the sheet.You will be returned to the chart worksheet, 
only there will now be three titles on it. 

Activity 3 Click on the text Title at the top of the chart. It should appear 
surrounded by a grey border and little black squares. The word “Chart 
Title” should also appear in the cell reference section of the formula bar. 
If you start typing, the text you type in the formula bar will replace the 
text on the sheet. Type the following title: "Graph of Sales per 
Region for Each Sales Rep". What you type will appear in the formula bar as 
you type it. When you click elsewhere on the chart or press <Enter> the title will 
take on the text you have just typed in. 

Activity 4 Now click once on the X-Axis label. Notice that the mouse cursor changes to an I-
Beam text editing cursor as you pass it across the X. Click on the X again, and you 
will notice the blinking text cursor that signifies you are editing text. Press the Delete  
or backspace key,  ←       , as appropriate to delete the X, and then type "Sales 
Reps". When you have finished click on any other part of the chart. 

Activity 5 This time select the Y-Axis label. Notice that the text, "Y axis", is rotated 90 degrees 
alongside the Y axis. If you start typing the text will be replaced by what you are 
typing. However, click on the Y again, just like you did for the X-axis. The Y 
swivels round and appears horizontally with a blinking I-Beam cursor alongside it. 
Delete the Y and type the following text: "Sales in Thousands". When you have 
finished click anywhere outside the editing area. The text appears alongside the Y 
axis, rotated 90 degrees. 

 



 

excel 2002 datapres md rev dl.doc, 12/02/03 16:49, DL 13 

Modifying a Chart Legend 

Objective To modify the legend to the chart that informs the reader what the different data 
series are - i.e. what the different colours refer to. 

Instructions You will use the Legend tab on the Chart Options dialog box. 

Comment Most charts are plotted with more than one set of data, the purpose of the chart often 
being to compare one set of data against another. It is therefore essential to label the 
different sets of data. You do this using a legend. 

 

Activity 1 Select the legend on the right hand side of the chart: 

 

Activity 2 Choose Format!Selected Legend... from the menu. The 
Format Legend dialog box appears: 

 

This box defines everything for the legend box, including the border and the patterns 
behind it. Patterns will be discussed in more detail later. For now, just click the tab 
marked <Placement>. This tab defines where the legend is positioned on the graph. 
Select Bottom: 

 

Click . Your legend should appear in a long thin box just underneath the 
X-axis. 
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Changing the Chart Type 

Objective To change the type of chart plotted whilst using the existing set of data. 

Instructions You will use the Chart Type... command from the Format menu. 

Comment Different graph types are useful for different kinds of data or for different emphasis 
on the data. 

 

Activity 1 Select Chart!Chart Type... from the menu. The following dialog box 
appears showing the types available: 

 

Select the Chart Type Area: 

 

Activity 2 Select the second subtype (Stacked Area) and click . The graph alters to 
show an area graph. Note that the Y axis has altered its scale for the new graph. Type 
2 Area graphs stack data to display the cumulated totals for each category over time. 
Before continuing, return the chart to the 2-D column type you originally had by 
going back to the Chart Type... dialog box. 
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Editing the display of the data 

Objective To alter the patterns and format of the series that are displayed. 

Instructions You will use the Selected Data Series command from the Format menu. 

Comments You may want to replace colours with patterns for a black and white printer, or to 
change the emphasis of data. 

 

Activity 1 Click once on one of the 
purple columns. 
Little boxes will appear on 
all the purple columns: 

 

 Then select Format!
Selected Data 
Series... from the 
menu. The Format Data 
Series dialog box will 
appear: 

This lets you alter the 
colours and patterns for the 
borders and fills of the 
columns. 

Activity 2 In the Area section select 
the white colour box under 
the Color: section. The 
Sample box should turn 
white. 

Activity 3 Now click on the Fill Effects 
... button. 
Make your choice of Gradient, 
Texture, or Pattern fill. It is also 
possible to use a picture as a fill. 

Activity 4 Click . Your change of 
fill is implemented on the Q2 data 
series.  

Activity 5 Now try changing the other two 
data series to be black and white but 
with different patterns. Notice that 
the legend records the change in 
patterns as you do them. 
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Editing axes 

Objective To alter the scales on which charts are plotted. 

Instructions You will click on the axes you wish to alter, then use the Selected Axis... 
command from the Format menu. 

Comments It is often desirable to change the scale of which axes are plotted. You can change it 
from a linear to a logarithmic scale, or you can change the starting and finishing 
values on the Y-axis to alter the appearance of a gradient. 

 

Activity 1 Click on the Y-axis. Two little boxes should appear, one at either end of the axis. 
Now select Format!Selected Axis... from the menu. A dialog box should 
appear. Click on the tab labelled Scale: 

 

This box allows you to alter the starting value, finishing value and increment units 
for the axis. You can also specify where you want the X axis to cross. 

Activity 2 Make these settings: Minimum: 30 Maximum: 80 

 Major Unit: 5 Minor Unit: 1 

You will note that as you go through the boxes, editing the contents, the check box 
on the left hand side becomes cleared. This is because you are removing the default 
values that Excel provides and inserting your own. When you are finished click 

. The differences between the individual sales reps are now more 
pronounced. 

Activity 3 Now double click on the X-axis. The tabbed dialog box should 
appear again, but this time select the Alignment tab. This 
controls the orientation of the text on screen. Drag the red 
marker around until the text is vertical, and click . 
All the text labels for the X-axis will be rotated 90 degrees.  
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Editing The Plotted Data 

Objective To alter the data that you actually want plotted on the chart. 

Instructions You will use the Add Data command from the Chart menu. 

Comment It is sometimes the case that you either want to add an extra series to what you are 
plotting, or else you want to use the format for the current chart to plot a new set of 
data with. To do this you change the Data Series you plot. 

 

Activity 1 Select Chart !Add Data to display: 

 

Activity 2 Click on the <Sheet1> tab at the bottom of the window to take you back to the 
worksheet. Select the range E6:G10. When you have done that click . 

Activity 3 You will have noticed that the Y-axis is now unhelpful as it still has the settings we 
gave it in the previous exercise. Double click on the Y-axis and reset all the Auto 
check boxes. 

The chart as it stands actually isn’t terribly informative. One alternative is to change 
it’s subtype to a stacked column chart. That way you would still get information 
about the separate quarters, but the columns would relate better to the lines. 

Activity 4 Choose Chart!Chart Type. Choose the second column subtype - the stacked 
one - and click . The whole chart is altered to become a stacked column 
chart. 
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Using the Chart toolbar 

Objective To use the Chart toolbar to make changes 

Instructions You will use some of the tools on the Chart toolbar 

Comment The Chart toolbar provides a set of shortcuts to achieve common charting tasks 
 

Activity 2 Click with the right mouse button on any toolbar and choose Chart from the list of 
toolbars displayed. The Chart toolbar appears: 

 

Activity 1 Select the Actual Sales series by clicking on it once with the mouse. A box will 
appear in each of the Actual Sales columns on the chart. Now click the drop down 

arrow on the Chart Type tool, . A palette of possible chart types appears. 
Select the 2-D line chart (4th down in the left hand column). 

The chart changes so that the Actual Sales form a line chart over the top of the 
column chart. Now select the Target Sales series and do the same for that. 

The chart will now appear as follows: 
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Changing Data Orientation 

Objective To change the way the data is plotted on the chart to give a different emphasis. 

Instructions You will use the Chart Wizard to alter the data you are plotting. 

Comments You are now going to alter the chart so that it displays the data by quarter rather 
than by sales rep. This will give a feel for what is happening to the sales over time. 

 

Activity 1 Click on the Chart Wizard button. Then click Next to display: 

 
Activity 2 Use the mouse to drag-select the range A6:E11 (you may need to move the dialog 

box in order to see what you are doing). 

Activity 3 In the Series in: section click the Rows radio button. This will put the quarters 
on the X-axis with the Sales Reps as the different series. Click . You will 
be taken back to the chart sheet with stacked columns representing the quarterly 
totals and a single line representing the average for each sales rep. 

Before continuing, change the colour of John’s column to a black and white pattern, 
change the chart back to unstacked columns and reinstate the Average series as a 
separate line. 
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Adding error bars 

Objective To add error bars to the data plotted on the chart. 

Instructions You will use the Selected Data Series command from the Format menu. 

Comments Excel allows some analysis of the data the chart display – error bars show possible 
error amounts in a data series. 

 

Activity 1 Click once on John’s data series to select it. Choose Format!Selected Data 
Series from the menu, then click the Y Error Bars tab: 

 

 

Activity 2 Set Display to Both, set Percentage to 5 and click  
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Adding a Trendline 

Objective To add a simple regression line to the data plotted on the chart. 

Instructions You will use the Trendline command from the Insert menu. 

Comments Excel allows some analysis of the data the chart displays – trendlines are a 
representation of trends in data series. 

 

Activity 1 Click the line 
representing the average 
score for the reps so 
that the boxes along the 
line are highlighted. 
Choose Chart!Add 
Trendline... from 
the menu to display the 
dialog box: 

Choose the Linear 
Trend box and click 

. A thick 
black line appears 
representing the linear 
trend of the average for 
the Sales Reps over the 
four quarters. 

Activity 2 Before you finish, you may want to tidy the chart up a bit. Try these: 

•  Double click on the Average line to call up the Format Data Series dialog 
box. Change the line weight to be thicker so that it stands out more. 

•  Change the X-Axis labels around so that they are easier to read. 

•  Change the X-Axis title to read "Sales per Quarter". 

•  Double click on the Chart title to open the Format Chart Title dialog box. 
Under the patterns tab give it an Automatic weight border with a shadow. 

•  Double click inside the axis, but not on a data series, to invoke the Format 
Plot Area dialog box. Change the background colour to a light grey. 

•  Double-click the tab labelled <Chart1> at the bottom of the window to highlight 
the current name. 
Type the name 
Quarterly Sales. 

Finishing off 

After finishing the exercises you should 
have a chart that looks something like 
the one shown on the right (with the 
addition of error bars). 

Save the workbook as CHARDONE in 
My Documents folder and close it. 
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Other ways of creating and working with charts 

As well as creating a chart in a sheet of its own, you can add one to a worksheet. This is called an 
embedded chart. You can also create and save your own chart format and then apply it to new charts 
using AutoFormat. If you are in real hurry you can create a chart completely automatically. 

This section also emphasises the use of the mouse for working with charts 

Create an embedded chart using the ChartWizard 
1. In the Stu/Excel folder, open REPORT.XLS 

2. Start the ChartWizard by clicking on  

3. Select the 3-D Column chart,  and then click Next 

4. Select cells B10:E13 and then click Next  

5. Add the Chart Title Encore Sales 

6. Click Next 

7. Click Finish to display the chart 

Manipulating chart objects using the mouse 
1. Select the title Encore Sales and drag it to the bottom-left corner. 

2. Click about one inch to the left of the trumpet label on the chart. A grey border appears around 
the main chart items. 

3. Enlarge the chart area in all directions until it fills the entire area of the chart object. 

4. Move the legend until it’s just above the title. You have now directly manipulated all the items 
within the chart area. However, one of the FY labels is not showing. This will be rectified in the 
what follows. 

Using the 3-D rotator 
Using the 3-D rotator, change the way your chart appears on the screen. 

1. Click the intersection of the axes at the zero, then drag the corner handle by the Trombone label 
(see the diagram below) about 5 centimetres to the left. 

2. Now rotate the chart while holding down the Ctrl (Mac: ") key. This rotates the chart with the 
images of the columns visible. 

3. Reset the 3-D chart to its 
original perspective: select 
Chart!3-D View....  from the 
menu. 

4. Click Default and then click 
OK to restore the chart to its 
original perspective. 

5. Adjust the chart rotation so 
that all labels are displayed, as 
shown to the right.  
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Formatting the chart using the mouse 
Using the mouse to format quickly the chart title and area colours. 

1. Double-click the title Encore Sales and then select the Font Tab. 

2. Select a different font size and click OK. 

3. Double-click the maroon columns to display the Format Data Series dialog box, and change the 
area colour to one you prefer. 

4. Double click each of the scales and the legend and set their font sizes to 8 pt. 

Using Custom Chart types 
1. Choose Chart!Chart Type . . . from the menu. 

2. Click the Custom Types tab, then select the chart type from the Chart Type box and click OK 

Creating and using your own custom chart format 
1. Choose Chart!Chart Type . . . from the menu. 

2. Select the Custom Types tab, click the User Defined button, then click Add 

3. In the Name box, type My Format, click OK then OK again 

4. Now change the chart format to a 2-D format, move the Title and Legend somewhere else and 
change some of the colours. 

5. Choose Chart!Chart Type . . . from the menu and apply My Format to the chart. 

Drag and Plot 
Use Drag and Plot to update your chart with additional data. 

1. Select cells F10:F13, drag this data over the chart, and when the handle is positioned over the 
chart, release the mouse button. Notice the borders on the chart object change appearance when 
the mouse pointer is dragged over the object. Also, the chart has been updated to include the FY 
Totals sales data for the Board of Directors chart. 

2. Click somewhere off the chart to deselect it. 

Ultra-rapid chart creation 
1. Select the data to chart 

2. Press F11 
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The drawing tools 

The drawing tools allow you to add decorative and explanatory material to a worksheet and chart. 

Right-click a toolbar or View!Toolbars. Then select Drawing to display the Drawing toolbar. 

Explore the Drawing toolbar and use what you find out to label the diagrams below: 

 

 

Click AutoShapes to 
get: 
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Using the Drawing tools 
In this exercise, you will use tools on the Drawing toolbar to add items of visual interest. 

Add and format a text box, and then draw an arrow from the text box to your data. 

1. With the right mouse button, click any toolbar to display the toolbar shortcut menu and then 
select Drawing. This displays the Drawing toolbar on the sheet. 

2. Click the Oval tool and draw an oval around the grand total at the bottom right of the data. 
Double click the oval on its outline and, in the dialog box, increase its weight and change its 
colour to No Fill. 

3. Click the Text Box button and, with the mouse, draw a text box on the right corner of the chart. 

4. Type Good Sales Figures! in the text box and click once outside it to deselect the box. 

5. Reselect the text box click the Shadow button on the Drawing toolbar and select a drop shadow. 
This adds a shadowed background to the text box. 

6. Right-click the text box to display the shortcut menu, and then choose Format Text Box…. 

7. Select the Colors and Lines tab, select a fill colour of your choice, and click OK. 

8. Select the Arrow button from the Drawing toolbar and draw an arrow from the text box to the 
grand total which is circled. The sheet should now look something like this: 
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Printing 

Objective To prepare the worksheet for printing and then print it 

Instructions You will use the File!Print Preview command to see how the sheet will 
print and then make changes to the print setup 

Comments You should always preview before you print 
 

Activity 1 File!Print Preview or click to see what the printout will look like. Click 

 to show column and margin markers: 

 

Drag the margin markers so that the whole sheet shows 

Activity 2 You can make other changes to the page setup by clicking . This gives the 
Page Setup box: 

  

 Click the Landscape button to flip your page on its side 
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Activity 3  Click the Margins tab and centre the printout on the page: 

  

Activity 4 Click the Header/Footer tab to change the headers which print at the top of every 
page or footers which print at the bottom of every page: 

  

Activity 5 Click Custom Header to display the Header dialog box. Put your name in the centre 
and use the date button to put the date on the left. 

Click Custom Footer to display the Footer dialog box. Use the Filename button to 
put the file name into the centre. 

Activity 6 Click   

 (You can click  to exit from Print Preview without printing. 
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Appendix 

Understanding Number Formats 
Each number that you want to display can consist of several elements: 

•  Digits that must be shown (e.g. zeros in a number with fixed decimal places). 
•  Digits that need not be shown (thousands when the number is 500) 
•  decimal points 
•  thousands indicators 
•  currency symbols 
•  percent symbols 
•  other symbols and number separators 

The format descriptors for each of these is as follows: 

0 numbers that must be shown 
# numbers that do not need to be shown, but the digits must be 

represented in the format for other reasons 
. where the decimal point appears 
, thousands separator 
% multiply by 100 and add a percent sign 
E- scientific notation 
"text" displays the text "text" in the cell 
[colour] Puts the contents of the cell into colour colour. 

So, for example, the following formats might be useful. The number entered into the 
cell is 16.475 in every case: 

Format Display in the Cell Note 

0.00 16.48 Rounds it up. 

#.## 16.475  

0,000.00 0,016.48  

0% 1648% Multiplied by 100 with % sign 

"Wrong Number" Wrong Number Just the text is displayed. 

In addition to these format definition codes, you can have different formats in the 
same cell depending on what the cell contains. The format code is split into four 
regions, each separated by a semicolon. The format up to the first semicolon is for 
positive numbers. The format up to the second semicolon is for negative numbers, 
the format up to the third semicolon is for zeros, and the format after the third 
semicolon is for text. So the following single format code can produce different 
results depending on the content of the cell: 

[Blue] #,##0.00;[Red]-(#,##0.00);[Green]0.00;"Rubbish" 

Content Display in Cell Colour of contents 
12 12.00 Blue 
-12 -(12.00) Red 
0 0.00 Green 
Any Text Rubbish Black 
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Defining Number Formats 
Objective To define and use your own number format. 

Instructions You will use the Number tab in the Format Cells dialog box and write your 
own format descriptor. 

Comments Being able to display numbers differently depending on what they are can be a great 
help to error check data as you enter it in, or spot anomalous figures. 

 

Activity 1 Select cell F3 (a blank cell which you can experiment on for the sake of 
demonstration), then choose Format!Cells... and the Number tab. 

Activity 2 The Number format dialog box appears as before. Select Custom from the left hand 
list box, and then choose the 4th format from the top: 

#,##0;[Red]-#,##0 

Note If you are writing your formats it is always a good idea to start with one that is 
close to what you want already. 

Activity 3 Click before the first character in the Type box. 

The Excel format descriptors are not limited to formatting positive numbers, negative 
numbers and zeros differently. You can define your own boundary conditions using 
the syntax [<number] at the start of the description. In this way you can define 
everything formatted by the first descriptor as being numbers above a certain 
boundary, everything formatted by the second descriptor as being numbers below a 
certain boundary, and everything else is formatted by the third descriptor. 

Activity 4 Edit the format description so that it looks like the one below: 
[Blue][>500] "DM "#,##0;[Red][<-500] "DM "-
#,##0;[Green]  

"DM " #,##0; "Wrong number" 

What this format descriptor says is: 

•  Format every number above 500 as blue, with the text DM in front and no 
decimal places. 

•  Format every number below -500 as red, with the text DM in front and no 
decimal places. 

•  Format every other number as green, with the text DM in front and no 
decimal places. 

•  Format any piece of text as the text "Wrong Number" in black. 

Activity 5 Click . Now enter each of the following in F3 to see the effect of the 
format descriptor on each value: 

 1000 -1000 100 Text 
Activity 6 When you have finished experimenting, select the cell F3 and press the <Del> key. 

This will clear the cell of all its contents. 

Conditional formatting 
The Format!Conditional Formatting… command on the menu provides a 
rapid way to set formatting which depends upon cell contents. 


